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Abstract—Conventional existing retrieval methods in remote
sensing (RS) are often based on a uni-modal data retrieval
framework. In this work, we propose a novel inter-modal triplet-
based zero-shot retrieval scheme utilizing a sketch-based repre-
sentation of RS data. The proposed scheme performs efficiently
even when the sketch representations are marginally prototypical
of the image. We conducted experiments on a new bi-modal
image-sketch dataset called Earth on Canvas (EoC) conceived
during this study. We perform a thorough bench-marking of this
dataset and demonstrate that the proposed network outperforms
other state-of-the-art methods for zero-shot sketch-based retrieval
framework in remote sensing.

Index Terms—Information retrieval, Database, Earth on Can-
vas, Sketches, Cross-modal retrieval, Zero-shot, Remote Sensing.

I. INTRODUCTION

W ITH the advancement in sensor technology, huge
amounts of data are being collected from various

satellites. Hence, the task of target-based data retrieval and
acquisition has become exceedingly challenging. Existing
satellites essentially scan a vast overlapping region of the Earth
using various sensing techniques, like multi-spectral, hyper-
spectral, Synthetic Aperture Radar (SAR), video and com-
pressed sensing, to name a few. With increasing complexity
and different sensing techniques at our disposal, it has become
our primary interest to design efficient algorithms to retrieve
data from multiple data modalities, given the complementary
information that are captured by different sensors. This type
of problem is referred to as inter-modal data retrieval.

In remote sensing (RS), there are primarily two important
types of problems, i.e., land-cover classification and object de-
tection. In this work, we focus on target-based object retrieval
part, which falls under the realm of object detection in RS.
Object retrieval essentially requires high-resolution imagery
for objects to be distinctly visible in the image. The main
challenge with conventional retrieval approach using large
scale databases is that, quite often, we do not have any query
image sample of the target class at our disposal. The target of
interest solely exists as a perception to the user in the form of
an imprecise sketch. In such situations where a photo query
is absent, it can be immensely useful if we can promptly
make a quick hand-made sketch of the target. Sketches are
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a highly symbolic and hieroglyphic representation of data.
One can exploit the notion of this minimalistic representative
of sketch queries for sketch-based image retrieval (SBIR)
framework [1].

While dealing with satellite images, it is imperative to
collect as many samples of images as possible for each object
class for object recognition with a high success rate. However,
in general, there exists a considerable number of classes for
which we seldom have any training data samples. Therefore,
for such classes, we can use the zero-shot learning (ZSL)
strategy. The ZSL approach aims to solve a task without
receiving any example of that task during the training phase.
This makes the network capable of handling an unseen class
(new class) sample obtained during the inference phase upon
deployment of the network.

While SBIR has gained substantial attention in computer
vision, this approach remains relatively unexplored in RS.
A few notable attempts in this area include [2], [3], [4],
where the authors have utilized the standard bench-marked
vision datasets of TU-Berlin and Sketchy. Lately, the idea
of SBIR has been recognized as hugely relevant in RS
of very high resolution (VHR) satellite images using deep
features [1], [5]. Both these tasks were accomplished using
their proposed Aerial-SI dataset. However, this dataset remains
unpublished for public usage. Further, Xu et al., [6] exploited
a related concept where they introduced the sketch-based
remote sensing image retrieval (SBRSIR) dataset containing
20 classes, with 45 sketches and 200 images in each class.
Even though the number of image samples is high, the number
of sketch samples are comparatively low and inadequate for a
conventional learning-based retrieval framework.

Moreover, since sketches lack texture properties, additional
samples were required for relevant discriminative learning.
The authors in [6] proposed an adversarial technique for
SBIR using a siamese metric learning technique. Adversarial
techniques often lead to unstable training if the min-max
problem is not intuitively designed. Also, they do not preserve
the reverse embeddings of image-based sketch retrieval (IBSR)
aspect of making the framework inter-modally-retrievable.
The framework becomes inter-modally-retrievable if we can
perform both SBIR and image-based sketch retrieval (IBSR).
Although cross-modal retrieval in RS seems to be only par-
tially explored [7], the ZSL retrieval strategy for cross-modal
sketch-image data remains practically unexplored, particularly
in RS applications.

In this work, we propose an efficient algorithm that performs
a sketch-based inter-modal retrieval from RS images (figure 1).
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Fig. 1. The complete pipeline of the ZSEoC framework for cross-modal retrieval of image→sketch or sketch→image.

In this aspect, to the best of our knowledge, all the work
that exists in literature only exploit the concept of sketch-
based retrieval technique in RS. However, our proposed model
is solely the one which introduces an inter-modal retrievable
aspect associated with it. Furthermore, we also extend it for
a ZSL based framework, which is a novel contribution in the
field of RS. Even though we have proposed a framework for
SBIR, the model is also robust to IBSR. We have carried all the
experiments on an original sketch and high-resolution image
bi-modal dataset called Earth on Canvas (EoC), proposed in
this study. In the following section, we demonstrate the Zero-
Shot retrieval architecture on the EoC dataset (ZSEoC)1.

II. METHODOLOGY

In the ZSL framework, we keep distinct classes in the
training and the testing phase. The classes that are trained
are referred to as the seen classes, while the classes that
the network encounters during the testing phase are referred
to as the unseen classes. For the unseen classes, the ZSL
frameworks necessitate attribute information, which aids in
recognizing the unseen classes during the testing phase. We
refer to this attribute information as the semantic information
in the remainder of the paper.

Let us denote two streams of incoming data fields for
Sketches and Images, denoted as S and I, respectively. We
aim to achieve an inter-modal retrieval model from S/I, given
a query image from a different modality I/S. For the ZSL
framework, we divide our dataset into seen and unseen class
images for training and testing sets, respectively. If we use L
to define the set of labels and W as the semantic prototype,
we can denote the training data as {Str, Itr, Ltr,Wtr}, and
the test data as {Sts, Its, Lts,Wts}. Furthermore, we strictly
ensure that the overlap between the seen and the unseen data
is a null-set (Ltr ∩ Lts = ∅). With this structure, we design
a unified latent feature representation for data from both the
modalities. This approach allows us to achieve a zero-shot-
based inter-modal retrieval framework, using the knowledge
from the semantic information. The workflow of our proposed
architecture is shown in figure 1.

1More details are provided in the supplementary file.

A. Network Construction
The network is incorporated using a two-stage training strat-

egy. In the first stage, we use transfer-learning from a network
pre-trained on the Image-Net dataset [8]. In the second stage,
we design an encoder-decoder based architecture, in which, for
the visual component, we use two separate encoders for the
image and sketch data, while in the semantic component, we
encode the attribute information. We use these representations
to carry out visual-to-semantic mapping for the ZSL part.

The visual encoders are a series of FCNs. Using feature
embeddings from the pre-trained network, we stack four FCNs
with 1024, 512, 256, and 128 nodes. In the semantic encoder
part, we use a word-vector embedding for preserving the
semantic topology. For example, runways and highways are
more similar to each other than they are to parking lots; or a
mobile home park is more similar to a building than it is to
a baseball court. To accommodate these aspects, we use the
standard word2vec encoding of the semantic class labels [9].

B. Objective Function
The overall objective function used in the proposed architec-

ture is the sum of the following four loss functions described
below:
a) Cross-entropy (CE) loss (Lce): An essential requirement
while designing our model is to preserve the semantic class
labels in the shared semantic space. For this purpose, we use
the cross-entropy loss function for both the modalities to retain
the semantic label information in the shared latent space (1),

Lce = CE
(
wsStr

)
+ CE

(
wiItr

)
(1)

where ws and wi are the learnable parameters for creating the
unified features. Here, wsS = Vs and wiI = Vi, where Vs
and Vi denote shared-space feature embeddings of the sketch
and image instances, respectively. Even though we project the
features onto a unified space, the shared features from both the
modalities are different as each input is distinct. Hence, Vs and
Vi denote the desired trained features of their corresponding
modalities.
b) Cross-triplet loss (Liii): In the second stage, we employ
three branches for data input streams, which we use to create
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the cross-triplets. Here, we use two types of triplets [10]: a)
we chose an anchor from the image dataset of class c, we
select positive and negative samples from sketch data of class
c and any class other than c (essentially, c′) respectively, b)
we chose an anchor from the sketch data of class c, while we
select positive and negative samples from image data of class
c and c′, respectively. This procedure displaces the negative
class instances away from the anchor class by at least a
margin α while making the same class instances of both the
modalities closer. Effectively, it aids in decreasing the inter-
modal distance while increasing the inter-class separability (3),

L3a = max (d (wsStrc , wiItrc )− d (wsStrc , wiItrc′ ) + α, 0)
(2)

L3b = max (d (wiItrc , wsStrc )− d (wiItrc , wsStrc′ ) + α, 0)
(3)

where α is a heuristically chosen margin value to push apart
non-similar classes in the feature space. The sketch-anchored
loss, L3a and the image-anchored loss, L3b together constitute
the total cross-triplet loss, Liii.
c) Cross-sample decoder loss (Ldl): The purpose of using
this loss function is to make the unified latent space domain-
independent. To achieve this, we bring the shared features of
the two modalities closer to each other in the embedding space
by performing an inter-modal data instance reconstruction.
This loss helps in better class-wise alignment of both the
modalities of data (4).

Ldl = ||wd
i Vs − wiItrc ||2F + ||wd

sVi − wsStrc ||2F (4)

where, wd
s and wd

i are the learnable parameters for the cross-
sample decoder network. Here, we want wd

i Vs to learn its
corresponding class feature encoding from S and similarly
wd

sVi from I (decoder network).
d) Cross-projection loss (Lcpl): To make the data projections
from both the modalities closer in the feature space, we mini-
mize the mean-square difference between these two represen-
tations and the semantic information in the embedding space.
This approach offers representations from both modalities akin
to the semantic projection while bringing them closer to each
other (5).

Lcpl = ||wiItrc −Wtr
c ||2F + ||wsStrc −Wtr

c ||2F (5)

Overall Objective function (L): The final objective function
is a combination of all the losses L = Lce + Liii + Ldl +
Lcpl. For training this network, we perform an optimization
on the final loss (L). However, since we have a non-convex
optimization problem at hand, we perform gradient descent on
each of these losses individually while holding others constant.
We solve the optimization problem by alternately minimizing
each loss functions individually using the mini-batch gradient
descent optimizer. Once we obtain the inter-modal embedding
of each of the data sample, we can provide a query sample
from either modality S/I, and find the k-nearest neighbour
(k-NN) instances from either of the modalities.

C. The Earth on Canvas (EoC) Dataset

We created the Earth on Canvas (EoC) dataset by utilizing
a subset of image classes from the standard UC-Merced

dataset [11]. The sketches were hand-drawn on paper by
several amateur artists to avoid style-bias and were then photo-
scanned with a resolution of 300-dpi. To place more attention
to the sketch object from the sizeable background and increase
its salience in the image, we cropped along the orthogonal hull
of each sketch. To bring all the images to a similar dimension,
we pad the remaining portion with a white background to
produce a size of 256×256-pixel dimension.

Out of the total 21 classes present in the Merced dataset,
we drop the four land-cover classes (viz. agricultural, beach,
chaparral, and forest), as we aim to solve an object retrieval
problem. Furthermore, we use a single class to represent the
dense-residential, medium-residential, sparse-residential, and
mobile-home park classes that describe the residential areas,
as they have a visually similar appearance. Hence, the VHR-
image data consists of 14 classes for which we have 100 image
samples for each class (i.e., a total of 1400 optical images).
We created 100 sketches for each of these 14 classes (i.e.,
a total of 1400 sketch images). Therefore, we have a total
of 2800 images in the database containing both optical and
sketch images sharing the same category labels. The classes
in the dataset are Airplane, Baseball diamond, Buildings,
Freeway, Golf course, Harbor, Intersection, Mobile home park,
Overpass, Parking lot, River, Runway, Storage tanks, and
Tennis court.

III. EXPERIMENTS AND RESULTS

We perform all our experiments on the proposed EoC
dataset. In the ZSL experimental framework, we consider ten
classes for training (i.e., seen classes) and four classes for
testing (i.e., unseen classes). We use the last four classes,
i.e., Runway, Water-tank, Tennis-court, and River classes as
the unseen classes. For pre-training the network, we explore
several standard models, namely: VggNet16 [12], ResNet50,
and ResNet101 [13] (results reported in Table I). By using
transfer learning from these pre-trained networks, we perform
fine-tuning on our dataset to encode the class labels in the
extracted feature space. For the semantic vector, we use a 300-
d vector embedding obtained from the pre-trained word2vec
embedding procedure. We use two variants of the network:
1) we use the 300-d vector directly for training, and 2) we
use two layers of FCNs to learn a 128-d distinct vector for
semantic information.

In the encoder part of the visual streams, we design two
variants of the network by taking two separate FCN net-
works for extracting a 300-d and a 128-d feature vector in
the shared latent space representation. Both these networks
have similar architecture. We have used four layers of FCNs
with dimensions 1024, 512, 256, and eventually, 300 or 128
depending on the variant of the network. We have used batch-
normalization and a leaky ReLU function to induce non-
linearity. The network that learns the 300-d shared features
is fed along with the 300-d word2vec embeddings directly.
We refer to this model as the fixed semantic vector variant.
The network that learns 128-d feature vectors from the visual
encoders uses a layer of FCN to project the 300-d semantic
vector onto a 128-d feature space. Since semantic information
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TABLE I
SBIR PERFORMANCE OF THE PROPOSED ZSEOC FRAMEWORK ON THE

EOC DATASET IN TERMS OF MAP (%) AND PRECISION AT TOP-100
(P@100) (%) VALUES.

Task EoC

mAP P@100 Feature
dimension

Baseline-I (VggNet-16) 0.221 0.234 4096
Baseline-II (ResNet-50) 0.236 0.254 2048
Baseline-III (ResNet-101) 0.269 0.284 2048
Baseline-IV (CNN) 0.30 0.284 128
Baseline-V (Pre-train + CNN) 0.196 0.284 128
ZS-SBIR [2] 0.395 0.421 1024
ZSIH (binary) [3] 0.452 0.487 64

ZSEoC-300 (fixed semantic vector) 0.686 0.698 300
ZSEoC-128 (latent semantic vector) 0.674 0.732 128

is learnt from the network, we refer to this model as the latent
semantic vector variant.

We create 14,000 triplets for each type of anchor while
training the network. In each batch, we make sure that an
equal number of sketch-anchored triplets and image-anchored
triplets are provided to avoid any training bias. To the best of
our knowledge, there does not exist any ZSL based inter-modal
retrieval algorithm in the literature. Therefore, in this respect,
we perform a few baselines for the sake of comparison. In
Baseline-I, we use the pre-trained weights from VggNet-16
and use a k-NN based approach to find the top-k retrieved
vales. For Baseline-II and Baseline-III, we use a similar frame-
work, but with ResNet-50 and ResNet-101, respectively. For
Baseline-IV, we obtain 128-d features by using a series of 2D
convolution layers, directly from the images and sketches. We
denote the convolutional layer parameters as conv <receptive
field size> − <number of channels>”. We use two layers
of conv3-64, followed by two layers of conv3-128. Both
these pair of convolution layers are followed by a maxpool
and a batch-normalization layer. This is then followed by
another conv3-256 and maxpool layer. Finally, the output is
fed to a fully-connected layer of dimension 128. Ultimately,
we combine the ResNet-101 pre-trained network with three
subsequent layers of 2D convolution (last three layers from
Baseline-IV) and use it as Baseline-V.

The proposed framework is also compared with the state-
of-the-art (SOTA) ZSL sketch-based image retrieval network
(ZS-SBIR) [2]. Similarly, we also compare our results with the
Zero-shot Image Hashing (ZSIH) network [3]. This technique
is a zero-shot sketch image retrieval model wherein the net-
work uses a generative hashing scheme for constructing the
semantic information. It is noteworthy that these are solely
SBIR type networks and do not support inter-modal retrieval
tasks. Therefore, to maintain integrity in comparison, the
SBIR method was evaluated using only the sketch-anchored
triplets. It can be noted from Table I that our ZSEoC frame-
work outperforms the current SOTA methods. Table II shows
the inter-modal retrieval results, along with the uni-modal
(sketch→sketch & images→images) retrieval results.

It is interesting to note that the uni-modal retrieval re-
sults are likewise efficiently encoded in this unified feature
embedding space along with the inter-modal ones, thus pro-

TABLE II
INTER-MODAL RETRIEVAL PERFORMANCE OF THE PROPOSED ZSEOC

FRAMEWORK ON THE EOC DATASET.

Inter-modal EoC Uni-modal EoC
mAP P@100 mAP P@100

Sketch→Image 0.686 0.698 Image→Sketch 0.612 0.632
Sketch→Sketch 0.719 0.737 Image→Image 0.839 0.855

(a) Image (b) Sketch

Fig. 2. Two-dimensional scatter plots of high-dimensional features generated
with t-SNE of image and sketch features, in the shared latent space, trained
with a fixed-semantic vector. Clusters with distinct colours denote separate
classes in the dataset.

viding better retrieval outcomes than the inter-modal results.
Therefore, the aforementioned indicates the efficiency of the
shared embedding space. Furthermore, figure 2 shows two-
dimensional scatter plots of the high-dimensional features
generated with the t-distributed stochastic neighbor embedding
(t-SNE) algorithm for image and sketch features, in the shared
latent space that is trained with a fixed-semantic vector.
Moreover, it can be noticed that the data instances for both
the modalities are separated and grouped in the unified space
using the ZSEoC model. Here, we also present a few inter-
modal retrieval results in figure 4, where the images with green
borders indicate the correctly retrieved images. In contrast, the
ones with red borders show incorrect results.

Fig. 3. Ablation study for understanding the contribution of each loss term in
the objective function. We study SBIR with fixed semantic vector and latent
semantic vector, and IBSR with latent semantic vector.

Ablation Studies: To investigate the effect of each loss
function, we perform an ablation study. For this purpose, we
run our experiments on three problem sets: i) sketch-based
image retrieval (SBIR) with fixed semantic space of 300-d, ii)
SBIR with a latent-semantic space of 128-d, and iii) IBSR. For
the first set of experiments, we used the total loss function,
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Fig. 4. A few top retrieved results from the zero-shot inter-modal framework. Alternate rows represent Sketch→Image and Image→Sketch retrievals.

except for the latent loss, which primarily aids in bringing the
two modalities closer to each other for a consistent retrieval
purpose. However, we can notice from Fig 3, that without this
loss function, there is a noteworthy decrease in the overall
performance of the system.

In the second set of experiments, we leave out the cross-
entropy loss function. In doing so, the features in the shared
embedding space lose their inter-class distances resulting in an
ineffective retrieval, which can be seen in figure 3. In the third
set of experiments, we exclude the cross-triplets loss function
from the overall objective function. A significant variation in
the performance between the SBIR and the IBSR modules is
noticed from figure 3. Therefore it is noted that the cross-
triplets loss aids in boosting both the inter-modal retrieval
frameworks. However, we can observe that the retrieval ability
of the framework significantly increases when retaining only
the single cross-triplet (i.e., either sketch anchored or image
anchored), while decreasing for the other. Therefore keeping
both sketch and image anchored triplets leads to an optimum
trade-off between both the performances.

In the fourth set of experiments, we exclude the decoder loss
function from L. Surprisingly, we still observe the excellent
performance of the framework. However, the inclusion of this
loss function provides an additional impetus in the execution of
the framework, making its performance better than the SOTA.
The last set of bar graphs in figure 3 displays the performance
of the complete model with the total objective function.

IV. CONCLUSION

We propose an aerial image and sketch-based inter-modal
zero-shot learning framework in remote sensing application2.
Our primary motivation is to project the multi-modal data
into a shared space for inter-modal retrieval. We extend this
concept to create a framework wherein we might not have
any training samples for some classes; however, there is a
possibility that we might find them at any given instance. We
exploit the notion of sketch-based image retrieval to tackle
the problem of insufficient query image for a target within a

2The Earth on Canvas dataset and the codes developed in this work are
made available at: https://github.com/ushasi/Earth-on-Canvas-dataset-sample.

class during the retrieval process. We propose a novel zero-
shot inter-modal architecture for RS image retrieval using the
EoC dataset introduced in this work. The performance of the
proposed algorithm exceeds the current SOTA results in SBIR.
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